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Introduction
Fixed Assets Monetary Correction is a tool that allows you to perform monetary 
correction for fixed assets. You can perform the monetary correction on the 
remaining cost of a depreciated asset, on the depreciation accrued for the year, and 
on the depreciation of the asset that is brought forward. You can enter the monetary 
correction coefficients specified by the tax authorities and perform these corrections 
for a single asset or for a group of assets.

Check for current instructions
This information was current as of February 2007. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics GP 
online Web site (http://go.microsoft.com/fwlink/?LinkID=79222) for the most 
current documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Monetary Correction of Fixed Assets, and how it integrates with the 
Microsoft Dynamics™ GP system.

To make best use of Monetary Correction of Fixed Assets, you should be familiar 
with systemwide features described in the System User’s Guide, the System Setup 
Guide, and the System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

The manual is divided into the following chapters:

• Chapter 1, “Setup and cards,” describes how to specify the accounts to be 
updated with the monetary correction and assign them to an account group, an 
asset class, or a specific fixed asset.

• Chapter 2, “Routines,” describes the process of performing monetary correction 
for a single asset or for an asset group.

• Chapter 3, “Inquiry and reports,” describes how to view the monetary 
correction amounts for the assets.

http://go.microsoft.com/fwlink/?LinkID=79222
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the 
current window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

Orientation Training
Accesses online tutorials that show you how to complete basic procedures within 
Microsoft Dynamics GP. Additional tutorials are available through the 
CustomerSource Web site.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.
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U.S. Payroll Updates
Provides access to tax updates for state and federal tax withholding. When you 
select an option, the process to install the updates will begin immediately.

Check with your system administrator before installing tax updates. To be sure that tax 
updates are installed correctly, refer to documentation for specific tax updates on the 
CustomerSource Web site.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com


M O N E T A R Y  C O R R E C T I O N  O F  F I X E D  A S S E T S 5

Chapter 1: Setup and cards
Use this information to specify the accounts that will be updated with the monetary 
correction of a company’s fixed assets. You can assign these accounts to a fixed 
assets account group, a fixed assets class, or to a specific fixed asset account. You can 
also enter the monetary correction coefficients for fixed assets as specified by the tax 
authorities.

When you set up Fixed Assets Monetary Correction, you can open each setup 
window and enter information, or you can use the Setup Checklist window 
(Microsoft Dynamics GP menu >> Tools >> Setup >> Setup Checklist) to guide you 
through the setup process. See your System Setup Guide (Help >> Contents >> 
select Setting up the System) for more information about the Setup Checklist 
window.

This information is divided into following sections:

• Enabling the monetary correction module
• Setting up the default devaluation accounts
• Assigning the devaluation accounts to a fixed asset account group
• Assigning the devaluation accounts to a fixed asset class
• Entering the monetary correction coefficients
• Modifying the date for monetary correction
• Assigning devaluation accounts to fixed assets

Enabling the monetary correction module

Use the Monetary Correction Setup window to perform the setups to allow 
monetary correction for a book. You can also set up to perform the monetary 
correction on the salvage value of an asset in a book.

To enable the monetary correction module:
1. Open the Monetary Correction Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Fixed Assets >> Monetary 
Correction)

2. Select a book ID to perform the monetary correction. The Description field 
displays the description for the selected book.
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3. Mark the Enable Monetary Correction checkbox to allow monetary correction 
for the selected book. You can perform the monetary correction for a single 
asset or an asset group associated with the book. Refer to Calculating the 
monetary correction for a single asset on page 11 and Calculating the monetary 
correction for an asset group on page 12 for more information.

4. Mark the Correct Salvage Values checkbox to perform the monetary correction 
on the salvage value of an asset. This option is available only if you have 
marked the Enable Monetary Correction checkbox.

5. Mark the Exclude Salvage Values from Mon. Corr. checkbox to specify the 
maximum salvage value to perform the monetary correction.

6. Enter the salvage value to exclude from monetary correction in the Assets Equal 
to or Less than field. The assets with salvage values that are equal to or less than 
the amount specified will not be considered during monetary correction.

7. Choose Save to save the monetary correction information you have set up, clear 
to clear the values, and Delete to delete the values you have entered.

Setting up the default devaluation accounts

Use the Company Devaluation Accounts window to set up the default devaluation 
accounts for a company. These accounts will be updated with the monetary 
correction of fixed assets. You must enter information in this window in order to 
perform monetary correction for fixed assets. These company devaluation accounts 
are used as the default accounts if you do not specify the devaluation accounts for 
an account group or an asset class. Refer to Assigning the devaluation accounts to a 
fixed asset account group on page 7 and Assigning the devaluation accounts to a fixed 
asset class on page 7 for more information.

To set up the default devaluation accounts:
1. Open the Company Devaluation Accounts window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Fixed Assets >> 
Company >> Additional >> Depreciation Accounts)

2. Enter or select a Fixed Asset Reappraisal account. This account will be updated 
with the monetary correction of the asset’s Net Book Value.

3. Enter or select a Reappr. Accrued Deprec. account. This account will be 
updated with the monetary corrections on the accumulated (life-to-date) 
depreciation of the asset.

4. Enter or select a Reappr. Accr. Deprec. Year account. This account will be 
updated with the monetary correction of the asset’s depreciation value 
accumulated during the fiscal year.
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5. Mark the Use Depreciation Start Date checkbox to calculate depreciation using 
the depreciation start date and not the first-use date. The First-use date is the 
default date.

6. Mark the Negative Depreciation = 0 checkbox to consider the negative 
monetary corrections of the asset as equal to zero. When there is no revaluation 
of the asset, the asset will retain the original value.

7. Choose Save to save the account information for the company, or Clear to clear 
the values in the window.

Assigning the devaluation accounts to a fixed asset 
account group

Use the Account Group Devaluation Accounts window to specify the devaluation 
accounts for an account group ID. You can define up to three accounts - Fixed Asset 
Reappraisal, Reappr. Accrued Deprec, and Reappr. Accr. Deprec. Year.

To assign the devaluation accounts to a fixed asset 
account group:
1. Open the Account Group Devaluation Accounts window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Fixed Assets >> Account 
Group >> Select an Account Group ID >> Additional >> Depreciation 
Accounts)

2. Enter or select a Fixed Asset Reappraisal account. This account will be updated 
with the monetary corrections of the asset’s Net Book Value.

3. Enter or select a Reappr. Accrued Deprec. account. This account will be updated 
with the monetary corrections on the accumulated (life-to-date) depreciation of 
the asset.

4. Enter or select a Reappr. Accr. Deprec. Year account. This account will be 
updated with the monetary correction of the asset's depreciation value 
accumulated during the fiscal year.

5. Choose Save to save the accounts, or Clear to clear the values in the window.

Assigning the devaluation accounts to a fixed asset 
class

Use the Asset Type Devaluation Accounts window to select the accounts that will 
be updated with the devaluation amount for an asset class.
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To assign the devaluation accounts to a fixed asset class:
1. Open the Asset Type Devaluation Accounts window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Fixed Assets >> Class >> 
Select a Class ID >> Additional >> Depreciation Accounts)

2. The Class ID and the Description fields display the information from the Class 
Setup window.

3. Enter or select a Fixed Asset Reappraisal account that will be updated with the 
monetary corrections of the asset’s Net Book Value.

4. Enter or select a Reappr. Accrued Deprec. account. This account will be updated 
with the monetary corrections on the accumulated (life-to-date) depreciation of 
the asset.

5. Enter or select a Reappr. Accr. Deprec. Year account. This account will be 
updated with the monetary correction of the asset’s depreciated value 
accumulated during the fiscal year.

6. Mark the 4% Impairment checkbox to provide discount on items that are in 
their first year of purchase and that are being depreciated for the first time.

7. Choose Save to save the account information for the Class ID, Delete to delete 
the devaluation accounts for the selected Class ID, or Clear to clear the values in 
the window.

Entering the monetary correction coefficients

Use the SII Currency Correction window to enter the monthly monetary correction 
values for the fixed assets, as declared by the tax authorities.
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To enter the monetary correction coefficients:
1. Open the SII Currency Correction window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Fixed Assets >> 
Coefficients SII)

2. Choose New Year to enter a year for which to specify the monetary correction 
percentages. Enter the percentage for each month as specified by the tax 
authorities. You can also modify the existing percentages for a year if required, 
by selecting it from the year list.

The monetary corrections for an asset purchased prior to the selected year, are entered in 
the Starting Capital row.

3. Choose Eliminate Year to delete a year for which you do not want to maintain 
the monetary correction percentages.

4. Choose Save to save the values you have entered, Clear to clear the values, or 
Cancel to close the window.

Modifying the date for monetary correction

Use the Mon. Corr. Date window to enter the monetary correction date for a 
selected book. This date is displayed when you are performing the monetary 
correction for a single asset. Refer to Calculating the monetary correction for a single 
asset on page 11 for more information.

To modify the date for monetary correction:
1. Open the Mon. Corr. Date window.

(Cards >> Fixed Assets >> Book >> Additional >> Mon. Corr. Date)

2. The Last Correction Date field displays the date on which the monetary 
correction was performed for the selected asset. You can modify this date if 
required. The modified date will appear in the Correction Date field in the 
Correct Single Asset window. Refer to Calculating the monetary correction for a 
single asset on page 11 for more information.
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3. Choose Save to save the correction date you have entered, or Cancel to cancel 
the process and close the window.

Assigning devaluation accounts to fixed assets

Use the Fixed Asset Devaluation Accounts window to select the accounts that will 
be updated with the monetary correction for a selected fixed asset.

To assign the devaluation accounts to fixed assets:
1. Open the Fixed Asset Devaluation Accounts window.

(Cards >> Fixed Assets >> Account >> Select an Asset ID >> Additional >> 
Depreciation Accounts)

2. The Asset ID and the Description fields display the values from the Asset 
Account window.

3. Enter or select a Fixed Asset Reappraisal account to perform the monetary 
corrections of the asset’s Net Book Value.

4. Enter or select a Reappr. Accrued Deprec account. This account will be updated 
with the monetary corrections on the accumulated (life-to-date) depreciation of 
the asset.

5. Enter or select a Reappr. Accr. Deprec. Year account. This account will be 
updated with the monetary correction of the asset’s depreciated value for the 
year.

6. Mark the 4% Impairment checkbox to provide discount on items that are in the 
first year of purchase and that are being depreciated for the first time.

7. Choose Save to save the information for the Asset ID, Delete to delete the 
devaluation accounts, or Clear to clear the values in the window.



M O N E T A R Y  C O R R E C T I O N  O F  F I X E D  A S S E T S 11

Chapter 2: Routines
Use this information to understand the process of performing monetary corrections 
and calculating depreciation for a single asset, or for a group of assets in one or 
more books.

This information is divided into the following sections:

• Calculating the monetary correction for a single asset
• Calculating the monetary correction for an asset group
• Depreciating assets in one or more books

Calculating the monetary correction for a single asset

Use the Correct Single Asset window to perform the monetary correction for a 
selected asset. You must have entered values for the respective periods for the year 
in the SII Currency Correction window to perform the monetary correction 
accurately. Refer to Entering the monetary correction coefficients on page 8for more 
information.

To calculate the monetary correction for a single asset:
1. Open the Correct Single Asset window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Fixed Assets >> 
Correct Single Asset)

2. Select an asset ID. The description for the asset is displayed below the selected 
asset.

3. Select a book for which to perform the monetary correction.

4. Enter a date up to which to calculate the monetary correction in the Date to 
Correct field. The date you enter must be within the current fiscal year.

5. The Correction Date field displays the date on which the monetary correction 
was last calculated. You can enter a date or modify the current date if required 
in the Mon. Corr. Date window. Refer to Modifying the date for monetary correction 
on page 9 for more information.

6. Choose Process to calculate the monetary correction for the selected asset.

7. Choose Cancel to cancel the process and close the window.
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Calculating the monetary correction for an asset 
group

Use the Correct Asset Group window to perform the monetary correction for an 
asset group or for all the assets in a book. You can create asset groups in the Select 
Assets window (Transactions >> Fixed Assets >> Select Assets). Refer to the Fixed 
Assets documentation for more information.

To calculate the monetary correction for an asset group:
1. Open the Correct Asset Group window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Fixed Assets >> 
Correct Asset Group)

2. Select an asset group ID. The Correct all assets option must be unmarked to 
select an asset group.

3. Mark the Correct all assets option to calculate the monetary correction for all the 
assets in the book.

4. Select a book ID for the monetary correction.

5. Enter a date up to which to calculate the monetary correction for the asset 
group. The date you enter must be within the current fiscal year.

6. Choose Process to calculate the monetary correction for the asset group.

7. Choose Cancel to cancel the process and close the window.

Depreciating assets in one or more books

Use the Depreciate Book window to depreciate a single asset or an asset group in 
one or more books. You can create asset groups in the Select Assets window 
(Transactions >> Fixed Assets >> Select Assets). Refer to the Fixed Assets 
documentation for more information.
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To depreciate assets in one or more books:
1. Open the Depreciate Book window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Fixed Assets >> 
Depreciate Book)

2. Select an asset group ID. The Depreciate all assets option must be unmarked to 
select an asset group ID.

3. Mark the Depreciate all assets option to depreciate all the assets in the book.

4. Select a book to depreciate.

5. Enter a depreciation date to depreciate the assets in the book. The date you 
enter must be within the current fiscal year.

6. Choose Process to depreciate the assets in the selected asset group ID.

7. Choose Cancel to cancel the process and close the window.
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Chapter 3: Inquiry and reports
Use this information to view the monetary correction transactions for assets and 
generate the monetary correction reports.

This information is divided into the following sections:

• Viewing the date of monetary correction
• Viewing the monetary correction information
• Generating monetary correction reports

Viewing the date of monetary correction

Use the Mon. Corr. Date Inquiry window to view the date on which the monetary 
correction was calculated for an asset.

To view the date of monetary correction:
1. Open the Mon. Corr. Date Inquiry window.

(Inquiry >> Fixed Assets >> Book >> Additional >> Mon. Corr. Date)

2. The Last Correction Date field displays the date on which the monetary 
correction was performed for the selected asset.

3. Choose Cancel to close the window after viewing the information.

Viewing the monetary correction information

Use the Financial Detail Inquiry window (Inquiry >> Fixed Assets >> Financial 
Detail) to view the assets for which you have performed the monetary correction. In 
the Source Doc. Filters group, unmark the All Documents checkbox and select the 
source document to view the monetary correction. You can select the following 
source documents to view the monetary correction information.

FACOR-CA  Select this source document to view the monetary correction on the 
the asset’s remaining value.

FACOR-CD Select this source document to view the monetary correction on the 
brought forward depreciation for the asset.

FACOR-DA Select this source document to view the monetary correction for 
assets that have an accumulated depreciation during the year.

The scrolling window displays the details of all the monetary correction 
transactions. Refer to the Fixed Assets Management documentation for more 
information about this window.
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Generating monetary correction reports

Use the Correction Report window to generate the monetary correction report for 
all assets or for assets that are discounted by 4% in their first year of purchase.

To generate monetary correction reports:
1. Open the Correction Report window.

(Reports >> Fixed Assets >> Correction Report)

2. Mark the Include Assets discounted by 4% checkbox to generate reports only 
for assets that are discounted by 4% in their first year of purchase. Leave this 
option unmarked to generate reports for all the assets.

3. Select the month in the Period field and enter the year for which to generate the 
report.

4. Choose Print to print the report, or Cancel to cancel the process and close the 
window.

5. The report displays the original and corrected values for the assets based on 
your selection.
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Glossary
Devaluation account

The account that is updated with the 
devaluation amount for an asset class.

Asset group
A collection of assets with similar 
characteristics.

Salvage value
The estimated value of the asset when it will 
be sold.

Monetary correction coefficient
Value specified by the tax authorities for 
monetary correction of assets.

Depreciation start date
The starting date from which the 
depreciation is calculated for an asset.

First-use date
The date on which the asset was first used.
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Index
A
Account Group Devaluation Accounts 

window, displaying 7
Asset Type Devaluation Accounts 

window, displaying 8

C
calculating monetary correction

asset group 12
single asset 11

changes since last release, information 
about 3

Company Devaluation Accounts window, 
displaying 6

Correct Asset Group window, displaying 
12

Correct Single Asset window, displaying 
11

Correction Report window, displaying 16
current upgrade information, accessing on 

the Web 3

D
Depreciate Book window, displaying 13
depreciating assets, explained 12
devaluation accounts

for a company 6
for an account group 7
for an asset class 7
for fixed assets 10

documentation, symbols and conventions 
2

F
Fixed Asset Devaluation Accounts 

window, displaying 10

H
help, displaying 2
Help menu, described 2

I
icons, used in manual 2

L
lessons, accessing 3
lookup window, displaying 3

M
Mon. Corr. Date Inquiry window, 

displaying 15
Mon. Corr. Date window, displaying 9
monetary correction

overview 5
viewing 15

monetary correction coefficients, entering 
8

monetary correction date
modifying 9

monetary correction date (continued)
viewing 15

monetary correction module, enabling 5
monetary correction reports, generating 

16
Monetary Correction Setup window, 

displaying 5

N
new features, information about 3

O
Orientation training, accessing 3

R
required fields, described 3
resources, documentation 2

S
SII Currency Correction window, 

displaying 9
source documents, types 15
symbols, used in manual 2

T
tutorial, accessing 3

U
upgrade information, accessing on the 

Web 3

W
what’s new, accessing 3
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